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BAB III 

METOLOGI PENELITIAN 

A. Pendekatan dan Metode Penelitian 

1. Pendekatan Penelitian 

Pendekatan pada penelitian ini menggunakan pendekatan kuantitatif. 

Pendekatan kuantitatif analisisnya pada data-data (angka) yang 

diakumulasikan melalui prosedur pengukuran lalu diolah dengan metode 

analisis statistika. Pada dasarnya, pendekatan kuantitatif dilakukan pada 

penelitian inferensial (dalam rangka pengujian hipotesis) dan 

menyandarkan kesimpulan hasilnya pada suatu probabilitas kesalahan 

penolakan hipotesis nihil. Dengan metode kuantitatif akan diperoleh 

signifikansi perbedaan kelompok atau signifikansi hubungan antar variabel 

yang diteliti. Pada umumnya, penelitian kuantitatif merupakan penelitian 

sampel besar (Sugiyono, 2016). 

Pendekatan kuantitatif termasuk dalam pendekatan positivisme yang 

digunakan untuk meneliti populasi dan sampel, teknik pengambilan sampel 

dapat dilakukan secara random, pengumpulan data menggunakan 

instrument penelitian, analisis data bersifat statistik dengan tujuan untuk 

menguji hipotesis yang ditentukan (Sugiyono, 2013). 

2. Metode Penelitian 

Metode penelitian yang digunakan dalam penelitian ini yaitu metode 

penelitian survei (Ex post facto). Menurut Sugiyono, (2015) penelitian Ex 

post facto merupakan suatu penelitian yang dilakukan untuk meneliti suatu 

peristiwa yang telah terjadi dan kemudian melihat ke belakang untuk 

mengetahui faktor-faktor yang dapat menimbulkan kejadian tersebut. 

Penelitian Ex post facto adalah penelitian di mana variabel-variabel bebas 

telah terjadi ketika peneliti memulai dengan pengamatan variabel terikat 

dalam suatu penelitian. 

B. Jenis dan Sumber Data 

Penelitian ini menggunakan jenis data kuantitatif, yaitu data yang 

dikumpulkan oleh peneliti berbentuk angka (Sugiyono, 2015). Adapun dalam 
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pengumpulan sumber data pada penelitian ini melakukan pengumpulan sumber 

data dalam wujud data primer dan data skunder: 

1. Data primer yaitu data yang langsung memberikan data kepada 

pengumpul data. 

2. Data sekunder yaitu data yang didapatkan secara tidak langsung sebagai 

penunjang untuk melengkapi data pada penelitian. 

Data primer pada penelitian ini berasal dari hasil penelitian lapangan yang 

didapatkan dari tanggapan para responden melalui Angket yang dibagikan 

kepada Peserta didik. 

1. Populasi 

Populasi merupakan keseluruhan subjek penelitian yang memiliki 

karakteristik tertentu dan relevan dengan fokus kajian yang sedang diteliti. 

Dalam penelitian yang berjudul “Pengaruh Gaya Kepemimpinan Visioner 

terhadap Karakteristik Peserta Didik”, populasi yang digunakan adalah 

seluruh pendidik dan tenaga kependidikan yang bekerja di sekolah tempat 

penelitian dilaksanakan. Pada tahun akademik berjalan, jumlah pendidik 

dan tenaga kependidikan tersebut tercatat sebanyak 32 orang, yang terdiri 

dari guru mata pelajaran, wali kelas, guru pembimbing, serta tenaga 

administrasi yang terlibat dalam penyelenggaraan layanan pendidikan. 

Pemilihan populasi pendidik dan tenaga kependidikan didasarkan pada 

pertimbangan bahwa mereka merupakan pihak yang berinteraksi secara 

langsung maupun tidak langsung dengan peserta didik dan juga memiliki 

pemahaman yang cukup terhadap gaya kepemimpinan kepala sekolah. 

Mereka dapat memberikan penilaian objektif terkait bagaimana kepala 

sekolah menerapkan gaya kepemimpinan visioner dalam mengelola 

sekolah, menyusun arah pengembangan, serta membangun budaya 

organisasi yang berdampak pada pembentukan karakteristik peserta didik. 

Selain itu, pendidik dan tenaga kependidikan memiliki pengalaman empiris 

dalam mengamati perubahan perilaku, kedisiplinan, kreativitas, dan 

karakter peserta didik, sehingga persepsi mereka menjadi sumber data yang 

penting dalam penelitian ini. 
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Dengan demikian, populasi sebanyak 32 orang tersebut dianggap 

relevan, representatif, dan mampu memberikan informasi yang diperlukan 

guna menjawab rumusan masalah dan tujuan penelitian secara 

komprehensif. 

2. Sampel 

Teknik pengambilan sampel yang digunakan dalam penelitian ini adalah 

sampling jenuh, karena seluruh anggota populasi dijadikan sebagai sampel 

penelitian. Teknik ini dipilih untuk menghindari bias pemilihan sampel serta 

memberikan gambaran yang menyeluruh mengenai kondisi variabel yang 

diteliti. (Sugiyono, 2015). 

Dalam penelitian ini, penentuan sampel dilakukan dengan 

menggunakan teknik total sampling atau sensus, yaitu suatu metode 

pengambilan sampel di mana seluruh anggota populasi dijadikan sebagai 

responden. Teknik ini dipilih karena ukuran populasi relatif kecil, sehingga 

peneliti dapat melibatkan keseluruhan anggota populasi tanpa menghadapi 

kendala beban kerja, waktu, maupun biaya yang berlebihan. Dengan 

menggunakan total sampling, semua informasi yang diperoleh dari populasi 

dapat tercakup secara menyeluruh, dan risiko terjadinya bias sampling dapat 

diminimalisir. 

Berdasarkan teknik tersebut, jumlah sampel yang digunakan dalam 

penelitian ini adalah 32 orang pendidik dan tenaga kependidikan, sesuai 

dengan jumlah populasi yang ada. Melibatkan seluruh anggota populasi 

diharapkan dapat menghasilkan data yang akurat, lengkap, dan representatif 

dalam menggambarkan pengaruh gaya kepemimpinan visioner kepala 

sekolah terhadap karakteristik peserta didik. Selain itu, penggunaan total 

sampling memberikan nilai tambah berupa keberagaman persepsi dan 

pengalaman dari setiap pendidik dan tenaga kependidikan, sehingga analisis 

yang dilakukan menjadi lebih mendalam dan komprehensif. 

Dengan demikian, sampel penelitian ini benar-benar mencerminkan 

kondisi populasi secara utuh, serta mendukung validitas penelitian dalam 
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mengukur dan menjelaskan hubungan antara gaya kepemimpinan visioner 

kepala sekolah dan karakteristik peserta didik. 

C. Teknik Pengumpulan Data 

Teknik pengumpulan data merupakan langkah yang dilakukan oleh peneliti 

untuk memperoleh data yang diperlukan dalam penelitian. Dalam penelitian 

ini, teknik pengumpulan data yang digunakan adalah sebagai berikut: 

1. Angket (Kuesioner) 

Angket merupakan teknik pengumpulan data yang dilakukan 

dengan cara memberikan seperangkat pertanyaan atau pernyataan tertulis 

kepada responden untuk dijawab. Angket digunakan untuk memperoleh 

data mengenai persepsi responden terhadap gaya kepemimpinan visioner 

kepala sekolah serta karakter peserta didik. 

Dalam penelitian ini, angket diberikan kepada pendidik dan tenaga 

kependidikan di SMP Manarul Huda Kabupaten Bogor sebagai 

responden penelitian. Instrumen angket disusun berdasarkan indikator 

dari masing-masing variabel penelitian, yaitu variabel gaya 

kepemimpinan visioner kepala sekolah sebagai variabel bebas (X) dan 

karakter peserta didik sebagai variabel terikat (Y). 

Setiap item pernyataan dalam angket menggunakan skala Likert, 

yang terdiri dari lima alternatif jawaban, yaitu: 

Skor  Kategori Jawaban 

5  Sangat Setuju (SS) 

4  Setuju (S) 

3  Ragu-ragu (RR) 

2  Tidak Setuju (TS) 

1  Sangat Tidak Setuju (STS) 

Skala Likert digunakan untuk mengukur sikap, pendapat, dan 

persepsi responden terhadap fenomena sosial yang diteliti (Sugiyono, 

2015). 
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2.  Observasi 

Observasi merupakan teknik pengumpulan data yang dilakukan 

dengan cara melakukan pengamatan secara langsung terhadap objek 

penelitian di lapangan. Melalui observasi, peneliti dapat memperoleh 

gambaran nyata mengenai kondisi sekolah, gaya kepemimpinan kepala 

sekolah, serta perilaku dan karakter peserta didik di lingkungan sekolah. 

Observasi dilakukan di SMP Manarul Huda Kabupaten Bogor 

dengan memperhatikan aktivitas kepala sekolah dalam memimpin, 

interaksi dengan guru, serta situasi pembinaan karakter peserta didik di 

lingkungan sekolah. 

3. Wawancara 

Wawancara merupakan teknik pengumpulan data yang dilakukan 

melalui proses tanya jawab secara langsung antara peneliti dengan 

informan untuk memperoleh informasi yang lebih mendalam mengenai 

objek penelitian. Wawancara digunakan sebagai data pendukung untuk 

memperkuat hasil penelitian yang diperoleh melalui angket. 

Dalam penelitian ini, wawancara dilakukan secara langsung kepada 

kepala sekolah serta beberapa pendidik di SMP Manarul Huda 

Kabupaten Bogor. Wawancara bertujuan untuk memperoleh informasi 

mengenai bagaimana kepala sekolah menerapkan gaya kepemimpinan 

visioner dalam mengelola sekolah, menyusun program pengembangan, 

serta membina karakter peserta didik. 

Melalui teknik wawancara ini, peneliti dapat memperoleh 

penjelasan yang lebih mendalam mengenai kebijakan, strategi 

kepemimpinan kepala sekolah, serta upaya yang dilakukan dalam 

membentuk karakter peserta didik di lingkungan sekolah. 

4. Dokumentasi 

Dokumentasi merupakan teknik pengumpulan data dengan cara 

mengumpulkan berbagai dokumen yang berkaitan dengan penelitian. 

Data dokumentasi digunakan sebagai data pendukung untuk melengkapi 

data yang diperoleh melalui angket, observasi, dan wawancara. 
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Dokumen yang dikumpulkan dalam penelitian ini antara lain: 

a. Profil sekolah SMP Manarul Huda 

b. Visi dan misi sekolah 

c. Data jumlah pendidik dan tenaga kependidikan 

d. Foto kegiatan sekolah yang berkaitan dengan pembentukan 

karakter peserta didik 

Melalui teknik dokumentasi ini, peneliti dapat memperoleh data 

yang lebih lengkap dan akurat mengenai kondisi objek penelitian. 

D. Teknik Analisis Data 

Analisis data merupakan tahapan kegiatan setelah terkumpulnya seluruh 

data dari responden ataupun dari sumber lainnya. Tahapan ini merupakan 

kegiatan mengelompokkan data-data sesuai dengan variabel dan kriteria 

respondennya, lalu data sesuai dengan variabelnya akan diteliti dilakukan 

perhitungan untuk melakukan pengujian hipotesis yang diajukan (Sugiyono, 

2016). Adapun Langkah-langkah dalam analisis data adalah:  

1. Uji Instrumen Penelitian  

Pengujian instrumen penelitian merupakan tahap penting dalam 

mengelola dan menganalisis data yang diperoleh dari responden, dengan 

menggunakan model pengukuran yang konsisten. Uji validitas, reliabilitas, 

dan perbedaan pada setiap item pertanyaan bertujuan untuk memastikan 

bahwa informasi yang diperoleh dari data tersebut akurat dan dapat 

dipercaya dalam konteks penelitian yang sedang dilakukan (Sugiyono, 

2016).  

a. Uji Validitas  

Pengujian validitas bertujuan untuk mengetahui kesesuaian antara 

data yang dikumpulkan dengan data yang benar-benar terjadi pada objek 

penelitian. Instrumen yang valid menunjukkan bahwa alat pengukuran 

yang digunakan untuk memperoleh data (melakukan pengukuran) 

adalah valid. Validitas berarti instrumen tersebut mampu mengukur apa 

yang semestinya diukur (Sugiyono, 2020). Pada penelitian ini, 

pengujian validitas dilakukan menggunakan metode korelasi Pearson 
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Product Moment melalui software IBM SPSS Versi 30. Adapun dasar 

pengambilan keputusan dalam uji validitas adalah: 

1) Jika nilai rhitung > rtabel maka instrumen dinyatakan valid. 

2) Jika nilai rhitung < rtabel maka instrumen dinyatakan tidak valid. 

3) Nilai rtabel diperoleh dengan df = n-2  

Taraf signifikan 10%  

Adapun langkah-langkah uji validitas dengan IBM SPSS 30 adalah 

sebagai berikut: 

1) Buka aplikasi IBM SPSS 30. 

2) Klik menu File > Open > Data, atau copy paste data dari 

Ms.Excel ke SPSS 30. 

3) Pada tampilan Variabel View, pastikan nama variabel, tipe data, 

label, dan skala pengukuran sudah benar. 

4) Pada menu utama, klik opsi Analyze > Correlate > Bivariate. 

5) Pada dialog “Bivariate Correlations”, pindahkan semua item 

pernyataan yang akan diuji validitasnya ke kotak Variables 

dengan cara memilih variabel dan klik tombol panah. 

6) Pastikan opsi Pearson pada bagian Correlation Coefficients 

telah tercentang. 

7) Pada bagian Test of Significance, pilih Two-tailed. 

8) Centang opsi Flag significant correlations. 

9) Klik OK untuk menjalankan analisis. 

b. Uji Reliabilitas  

Pengujian reliabilitas digunakan untuk mengetahui konsistensi data 

pada waktu yang berbeda. Instrumen yang reliabel adalah instrumen 

yang apabila digunakan berkali-kali untuk mengukur objek yang sama, 

akan menghasilkan data yang konsisten (Sugiyono, 2020). Pada 

penelitian ini, uji realibilitas dilakukan menggunakan metode 

Cronbach’s Alpha melalui software IBM SPSS Versi 30. Adapun 
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langkah-langkah uji realibilitas dengan IBM SPSS 30 adalah sebagai 

berikut: 

1) Buka aplikasi IBM SPSS Versi 30. 

2) Input data per item dari masing-masing variabel pada kolom 

lembar kerja IBM SPSS 30. 

3) Pada tampilan Variable View, pastikan nama variabel, tipe data, 

label sudah benar. 

4) Untuk setiap variabel, pada kolom Measure pilih Scale. 

5) Di menu utama, klik Analyze > Scale > Reliability Analysis. 

6) Pindahkan seluruh item pernyataan untuk satu variabel pada 

bagian Items serta pastikan Model pengujian yang dipilih ialah 

Alpha. 

7) Klik menu Statistics lalu ceklis opsi Scale if item deleted > 

Continue. 

8) Tahap terakhir klik OK, maka hasilnya akan muncul. 

9) Kriteria suatu alat ukur dikatakan reliabel dengan penggunaan 

teknik Alpha Cronbach, jika nilai Cronbach’s Alpha pada SPSS 

> 0,6. Maka Dinyatakan Reliable 

2. Analisis Parsial Per Indikator 

Analisis statistik deskriptif dipakai untuk memberikan uraian atau 

mendeskripsikan data dalam variabel dengan melihat nilai minimum, 

maksimum, mean (rata-rata), serta standar deviasi. Untuk melakukan 

analisis statistik deskriptif melalui SPSS 30 dapat ditempuh melalui 

langkah-langkah berikut:   

1) Masukan jumlah total masing-masing variabel;   

2) Klik analyze – descriptive statistiks – descriptive;   

3) Pindahkan data ke tabel variabel;  

4) Klik options dan ceklis mean, std. Deviation, maximum dan 

minimum;   

5) Klik continue lalu klik OK 
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Rumus yang digunakan adalah sebagai berikut:  

𝑀= ∑ fxi∶N 

Keterangan :  

M : Mean/rata-rata  

∑fxi : Hasil kuisioner variabel  

N : Jumlah responden  

Kemudian dari hasil perolehan nilai mean tersebut setiap variabel 

indikator penelitian diinterpretasikan ke dalam rentang interval berikut ini 

(Sugiyono, 2015): 

Table 3. 1 Rentang Interval 

Nilai Interval Kategori 

1,00-1,79 Sangat Rendah 

1,80-2,59 Rendah 

2,60-3,39 Sedang/Cukup 

3,40-4,19 Tinggi 

4,20-5,00 Sangat Tinggi 

Sumber: (Sugiyono, 2019) 

3. Uji Asumsi Klasik 

a. Uji Normalitas  

Uji normalitas merupakan teknik analisis data yang digunakan 

untuk mengetahui apakah data yang diperoleh terdistribusi normal atau 

tidak. Apabila terdistribusi normal, maka pengujian hipotesis dapat 

dilakukan. Pada penelitian ini menggunakan rumus yang 

dikembangkan oleh Kolmogorov Smirnov dengan menggunakan SPSS 

30 (Sugiyono, 2015).  

Jika dari hasil uji yang dilakukan diperoleh probabilitas 

(asymptotic significance) > 0.05, maka data tersebut terdistribusi 

normal dan sebaliknya jika < 0.05 maka data tersebut tidak terdistribusi 

normal.  
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b. Uji Linearitas  

Uji Linearitas ini bertujuan untuk menentukan apakah terdapat 

hubungan linier antara variabel bebas dan variabel terikat. Ini dilakukan 

dengan menggunakan garis regresi dan menghitung nilai F atau 

menerapkan analisis varian. Tujuan utama dari uji ini adalah untuk 

mengetahui apakah pola hubungan antara variabel bebas dan variabel 

terikat dapat dimodelkan dengan garis lurus atau tidak (Sugiyono, 

2016).  

Dalam hal ini, penulis akan menolak hipotesis model regresi 

linier jika, F ≥ F(1 - α) (k-2,n-k). Untuk distribusi F yang akan diambil 

dk pembilang = (k-2) dan dk penyebut = (n-k). 

4. Uji Hipotesis 

a. Analisis Regresi Linear Sederhana 

Analisis regresi linear sederhana digunakan untuk memprediksi 

atau menguji pengaruh satu variabel bebas (X) terhadap variabel 

terikat (Y). Penelitian ini melakukan pengujian analisis regresi 

sederhana dengan menggunakan software IBM SPSS Versi 30.  

Berdasarkan pengolahan data, pengambilan keputusan regresi linear 

sederhana dapat mengacu pada hal yaitu membandingkan nilai 

signifikansi dengan nilai probabilitas 0,05. 

1) Signifikansi < 0,05: variabel berpengaruh signifikan. 

2) Siginifikansi ≥ 0,05: variabel tidak berpengaruh signifikan. 

Selain itu, bandingkan nilai t hitung dengan t tabel. 

3) thitung > ttabel: variabel berpengaruh signifikan. 

4) thitung ≤ ttabel: variabel tidak berpengaruh signifikan. 

Adapun langkah-langkah untuk regresi linerar sederhana dengan 

IBM SPSS 30 adalah sebagai berikut: 

1) Buka program IBM SPSS 30. 

2) Input data dari masing-masing variabel pada kolom lembar 

kerja IBM SPSS 30. 

3) Klik Analyze > Regression > Linear. 
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4) Masukkan variabel dependen ke Dependent dan variabel 

independen ke Independent(s). 

5) Klik Statistics. 

6) Klik Plots. 

7) Klik OK. 

b. Pengujian Parsial (Uji T) 

Uji t merupakan teknik statistik yang kerap digunakan dalam 

penelitian kuantitatif untuk membandingkan nilai rata-rata antara 

dua kelompok data. Pengujian ini tergolong dalam kategori statistik 

inferensial parametrik yang bertujuan menguji hipotesis dengan cara 

mengamati nilai signifikansi. Uji t pada hakikatnya menunjukkan 

sejauh mana pengaruh satu variabel independen (X) dalam 

menjelaskan variasi variabel dependen (Y). Adapun rumus uji-t 

yaitu sebagai berikut: 

 t =
𝑟√𝑛−2

√1−𝑟4
 

Keterangan:  

r = korelasi parsial yang ditemukan  

n = jumlah sampel  

t = thitung yang selanjutnya dikonsultasikan dengan ttabel  

Hipotesis yang diajukan:  

1) Hipotesis Alternatif (Ha): Terdapat pengaruh Gaya 

Kepemimpinan Visioner Kepala Sekolah terhadap Karakter 

Peserta Didik di SMP Manarul Huda Kabupaten Bogor. 

2) Hipotesis Nol (Ho): Tidak Terdapat pengaruh Gaya 

Kepemimpinan Visioner Kepala Sekolah terhadap Karakter 

Peserta Didik di SMP Manarul Huda Kabupaten Bogor. 

Kriteria: 

1) thitung > ttabel atau Signifikansi < 0,05: berpengaruh signifikan. 

2) thitung ≤ ttabel atau Siginifikansi ≥ 0,05: tidak berpengaruh 

signifikan. 
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5. Uji Koefisien Determinasi 

Koefisien determinasi (R2) pada dasarnya mengukur sejauh mana 

kemampuan model dalam menjelaskan variasi variabel dependen. Nilai 

koefisien determinasi berkisar antara nol dan satu. Jika nilai koefisien 

korelasi telah diketahui, maka untuk memperoleh koefisien determinasi 

dapat diperoleh dengan cara mengkuadratkannya.  

Adapun langkah-langkah untuk regresi linerar sederhana dengan 

IBM SPSS 30 adalah sebagai berikut: 

1) Buka program IBM SPSS 30. 

2) Input data dari masing-masing variabel pada kolom lembar 

kerja IBM SPSS 30. 

3) Klik Analyze > Regression > Linear. 

4) Masukkan variabel dependen ke Dependent dan variabel 

independen ke Independent(s), klik tanda panah. 

Klik OK, maka akan muncul hasil output koefisien determinasi 

fokus pada hasil output Model Summary. 

E. Tempat dan Waktu Penelitian 

1. Tempat 

Adapun Lokasi penelitian dilaksanakan di SMP Manarul Huda Jl. Pasir 

Angin, Cipayung Datar, Kec. Megamendung, Kabupaten Bogor, Jawa Barat 

16770. 

2. Waktu 

Penelitian ini dilaksanakan pada semester ganjil tahun ajaran 

2024/2025.  

Table 3. 2 Linimasa Penelitian 

 Tahun     2025     

No  Kegiatan Penelitian  Jan  Feb  Mar  Apr  Mei  Juni  Juli  

1  Pengajuan Judul                

2  Penyusunan Proposal                
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 Tahun     2025     

3  Ujian Proposal                

4  Bimbingan Bab 1-3                

5  
Kunjungan lapangan dan 

Penyebaran  
Angket  

          
    

6  Analisis dan Pengolahan Data                

7  Penyusunan Laporan                

8  Pelaporan Hasil Penelitian                

 


